
Iteration and Animation in Microsoft Excel 2003  
 

Introduction 

When a formula on an Excel worksheet refers back to its own cell (either 
directly or indirectly) it is called a circular reference. A simple example of 
such a formula would be =A1+1, held in cell A1. This indicates that the 
current value held in A1 should be incremented by 1 and that this new value 
should in turn be increased by 1 again. This is called iteration. Excel 
continues the process until a criteria or limit is reached. Iteration is used, for 
example, to solve equations and optimization problems - see Goal Seek 
and Solver in Microsoft Excel for further details. 

You can control the iteration either by setting a fixed number of iterative 
steps or by limiting the degree any cell can change within a single iteration. 
By definition, a circular reference is never completed, so you can re-run the 
iteration by a similar amount over and over again.  

Fine control of the iterative process can be achieved through the use of 
special controls - spin buttons, scroll bars, sliders etc. By adding these to 
your worksheets, you can make iteration very simple to use, even by those 
who know nothing of the process. If these are combined with graphical 
output of the results then the effects can be spectacular. Your charts will 
suddenly become animated.  

 

Simple Iteration 

The first exercise introduces you to circular references and iteration, and 
how to control them.  

1. Start up Excel as usual or click on [New] to start with a new file   
2. In cell A1 type =a1+1 then press <right arrow>  

 

http://www.its.rdg.ac.uk/documents/training/excel/animation/
http://www.its.rdg.ac.uk/documents/training/excel/solver
http://www.its.rdg.ac.uk/documents/training/excel/solver


A warning now appears because you have entered a circular reference. 
More often than not, you have typed in a formula incorrectly and don't want 
the circular reference (and you would click on [OK] to resolve it). Here, 
however, you do want it so: 

3. Click on the [Cancel] or press <Esc> to cancel the warning message  
4. Next, open the Tools menu and choose Options... then move to the 

Calculation tab  

 

When carrying out iterations, it's a good idea to turn automatic calculation 
off. If you don't then every time you enter a new value or formula into any 
cell, the iterative process runs. 

5. Set Calculation to Manual by clicking in the option button provided  
6. Next, turn on Iteration by clicking the check box and reset Maximum 

iterations: to 1  
7. Press <Enter> for [OK] then press <F9> and note what happens  

You should find that the value held in A1 changes from 0 to 1.

8. Hold down <F9> to recalculate over and over again - the value in A1 
should steadily rise  

9. Repeat steps 4 to 7 and change Maximum iterations: to 10  
10. Repeat step 8 - the values in A1 should increase by 10 each time  



Though the values shown jump by 10, in fact the value held in A1 increases 
in steps of 1 each time. The recalculation stops after 10 iterations but the 
process is so quick you don't see it happening. To prove this: 

11. In cell B1 type =if(b1<17,b1+1,b1) - ie only increase B1 if its value is 
<17  

12. Press <left arrow> then <F9> once - B1 jumps to 11  
13. Press <F9> again - the iteration stops with B1 equal to 17 (and will 

remain so)  

By setting a condition with the IF function, the circular reference only runs 
up until the criteria is met. Meanwhile, the value in A1 continues to rise 
indefinitely as there is no such limitation. You can also see iteration taking 
place if the number of iterations is large: 

14. Repeat steps 4 to 7 and change Maximum iterations: to 10000  
15. Press <F9> once and watch what happens - note also the iteration 

count on the Status Bar in the bottom left corner  

There's another way to limit iteration (apart from setting a maximum number 
of iterations) and that's to limit the degree of change which takes place in a 
cell. 

16. Repeat steps 4 to 7 but this time change Maximum change: to 1.001  
17. Press <F9> and watch what happens  

The formula in cell A1 increases the value in the cell by just 1 each time. 
Because the maximum change allowed (1.001) is larger than the result of 
each iteration (add 1), the calculation stops after only one iteration. It isn't 
quite so obvious what's happening here, so try the following: 

18. In A1 type 100 then in B1 type =(a1+b1)/2 and press <Enter> - the 
result is 50  

19. Press <F9> and the next result is 99.21875  

This isn't (100+50)/2, which would be 75. Excel has taken this value for the 
next iteration (ie 175/2) because neither has the maximum change (1.001) 
been exceeded nor the maximum number of iterations (1000). In fact, four 
iterations were carried out before the maximum change allowed stopped 
the process. Thereafter, only one iteration will take place each time. To see 
this: 



20. Keep pressing <F9> and watch what happens - the calculation ends 
with a value of 100  

Note that only one set of iteration criteria can be set at any one time - you 
can't have different criteria for different cells. 

 

Resetting the Starting Values 

To reset the starting values, you simply have to re-enter or edit the 
recursive formula:  

1. Move to cell B1 and press <F2> to enter edit mode   
2. Change the formula to read =(a1+b1)/3 then press <Ctrl Enter> - if 

you didn't know it already, <Ctrl Enter> enters the formula but also 
maintains the position of the active cell  

3. Press <F9> a few times and watch what happens - the final result this 
time should be 50  

You do not have to enter a new formula to reset the starting values: 

4. With B1 still the active cell, press <F2> then <Ctrl Enter> without 
changing the formula - the first iterative value of 33.33333 appears 
(press <F9> if you want to check iteration still works)  

Resetting the starting values by having to re-enter the recursive formula 
isn't immediately obvious and you might like to provide a simple mechanism 
for this, particularly if the spreadsheet is being used by people other than 
yourself: 

5. Press <F2> and edit the formula in B1 to read 
=if(b2="yes",0,(A1+B1)/3)  

6. Press <Enter> and in cell B2 type yes (press <Ctrl Enter>)  
7. Press <F9> - B1 is reset to 0  
8. Press <Delete> to clear B2 followed by <F9> - the iteration process 

starts up again  

Obviously you would need to provide instructions (eg text in cell A2 or a 
comment attached to cell B2) to explain how to carry out the above. 

 

 



Chart Animation 

Iteration shows up best when the values it generates are plotted on a chart. 
This next example traces the SIN and COS functions - these give values 
between 1 and -1 in a wave motion. Begin by resetting the iteration limits 
and cell values/formulas: 

1. Open the Tools menu and choose Options... then move to the 
Calculation tab  

2. Set Maximum iterations: to 1 and Maximum change: to 0.001 - press 
<Enter> for [OK]  

3. Move to cell A1 and type x - press <right arrow>  
4. Continue by typing sin and cosine into cells B1 and C1  
5. Move to cell A2 and type =if(a2<100,a2+1,0) - press <right arrow>  
6. Continue by typing =sin(a2/10) and =cos(a2/10) into cells B2 and 

C2 and press <Enter> - note that these functions work on radians, not 
degrees  

Now plot these values on a graph: 

7. Select cells A1 to C2 by dragging through them using the mouse  
8. Click on the [Chart Wizard] toolbar button  
9. At Step 1 of the wizard choose XY (Scatter) - press <Enter> for 

[Next>]  
10. At Step 2, set Series in: to Columns - press <Enter> for [Next>]  
11. There's no need to add titles etc at Step 3, just press <Enter> for 

[Next>]  
12. At Step 4, set Place Chart: to As new sheet: - press <Enter> for 

[Finish]  

Your graph will appear on a new Chart1 chart sheet. You now need to 
modify the axes settings: 

13. Double click on the vertical Y-axis and move to the Scale tab in the 
Format Axis window  



 

14. Under the Auto settings, for Minimum: turn off the Auto check box and 
type a value of -1  

15. For Maximum: turn off the Auto check box and type a value of 1  
16. Change the Value (X) axis Crosses at: to -1 - the settings should 

now be as shown above, press <Enter> for [OK]  
17. Now, double click on the horizontal X-axis  
18. Repeat steps 14 and 15 (turning off Auto) but set Minimum: to 0 and 

Maximum: to 100  
19. Finally press <Enter> for [OK] - your chart is ready for animation  
20. Hold down <F9> and watch what happens  

It would be nice if the points were plotted in full on the screen. To do this, 
you need to plot the complete set of values, not just a single pair. First, you 
need to calculate them: 

21. Move back to the data by clicking on the Sheet1 tab  
22. In cell A3 type =a2+1 then position the mouse cursor over the cell 

handle and drag the formula down to cell A101  

The resultant values look wrong (they are all the same) but this is because 
automatic calculation has been switched off. The correct values will appear 
when you restart the iteration. 

23. Press <up arrow> then move back to cell A3 and type =a2+1-100 and 
press <Enter>  



24. Next, select cells B2 and C2 then double click on the range handle to 
copy these formulae down the columns - press <F9> to recalculate 
them  

25. Next, move back to the chart - click on the Chart1 tab  
26. Open the Chart menu and choose Source Data...  
27. Amend the Data range: to read =Sheet1!$A$1:$C$101 - press <Enter> 

for [OK]  
28. Hold down <F9> and watch what happens  

Using Controls with Animation 

Having to press <F9> to run iterations isn't very user-friendly. More 
importantly, it doesn't give you full control if you want to run an iteration 
backwards. To do this, you need to use special controls such as a spin 
button, scroll bar or slider. These are held in the control toolbox. To display 
this: 

1. Open the View menu and choose Toolbars and select Control 
Toolbox - the toolbar appears  

 

There are a couple of hundred different controls available - the most 
commonly-used are shown on the toolbar, while others can be accessed via 
the [More Controls] button - the last one on the toolbar. In fact, the toolbar 
is split into two sections - the first three buttons are used to set up what 
happens when you use the controls on the rest of the toolbar. 

There's one disadvantage in using controls, namely that they can only be 
used on worksheets, not on chart sheets. Before you try them out, move the 
current chart onto Sheet1: 

2. Open the Chart menu and choose Location...  
3. Select the option to Place chart: As object in: Sheet1 - press <Enter> 

for [OK]  
4. Enlarge the chart by dragging out the bottom right corner handle  

One major advantage of using controls is that they perform all the iterations 
for you - you don't need manual calculation set on. This also means that 
you can have more than one control with different settings - ie you are not 
restricted by the iteration criteria settings. 



5. Click on any cell away from the chart (to deactivate it)  
6. Open the Tools menu and choose Options... then move to the 

Calculation tab  
7. Set Calculation: to Automatic and turn off Iteration: - press <Enter> for 

[OK]  
8. [Cancel] the circular recursion warning message if it reappears  

The sections which follow show you how to make use of some of the tools.  

 

Spin Button Controls 

Spin Button       Properties       Design Mode / Exit Design Mode    

Start with a spin button control. This can be used to change the value in a 
specified cell between a maximum and minimum value. 

1. Click on the [Spin Button] icon in the Control Toolbox - a small Exit 
Design Mode toolbar appears and the corresponding (first) button in 
the Control Toolbox is activated  

2. Move the mouse cursor into an empty cell (eg E1) then hold down the 
mouse button and drag out a suitably-sized spin button control (eg 
covering three rows deep and up to half a column wide) - release the 
mouse button  

3. Once the spin button has appeared (it can take a few seconds), click 
on the [Properties] button on the Control Toolbox (the second from the 
top) - the Properties window appears:  



 

4. Set the LinkedCell to a2 then [Close] the Properties window  
5. Close the design by clicking on either of the [Exit Design Mode] 

toolbar buttons  
6. Click on cell A2 and replace the formula by the value 0 (press 

<Enter>)  
7. Finally, point to the increase (up arrow) spin button and hold down the 

mouse button  
8. Also try the decrease (down arrow) spin button  

You'll find you can run the animation forwards or backwards, though it stops 
when it reaches 100 or 0. If you look at the picture of the SpinButton 
Properties, above, you'll see that these are the default values for Max and 
Min, respectively. 

9. Finally, repeat steps 1 to 5 to create a second button but, at step 4, 
also change the SmallChange setting from 1 to 10  

10. Test out the new button - you'll find you get 10 iterations at a time  

 

 

 



A Scroll Bar Control 

Scroll Bar    

A scroll bar control offers the same features as a spin button, but additional 
ones too: 

1. Click on the [Scroll Bar] button in the Control Toolbox  
2. Move the mouse cursor into an empty cell (eg G2) then hold down the 

mouse button and drag out a scroll bar control (eg covering three or 
four cells horizontally)  

3. Next click on the [Properties] button in the Control Toolbox  
4. Set the LinkedCell to a2 then, Max to 100 and LargeChange to 10  
5. [Close] the Properties window then click on the [Exit Design Mode] 

toolbar button  
6. Use the scroll bar as you would any other scroll bar, ie: 

a) Position the mouse cursor over either end and hold down the mouse 
button or 
b) Drag the slider block to the left or right, or 
c) Click to the left/right of the block to jump in steps of 10 (the 
LargeChange setting)  

A Slider Control 

More Controls       Build Code    

Another control which is sometimes used is a slider. This isn't nearly so 
simple to use, however, as not all the settings you require are present in the 
Properties window. You have to write your own effects using Microsoft 
Visual Basic! 

1. Click on the [More Controls] button in the Control Toolbox - a list of 
controls appears:  

 



2. Scroll down to find Microsoft Slider Control 6.0 (SP4) and click to 
select it  

3. Move the mouse cursor into an empty cell (eg G4) then hold down the 
mouse button and drag out a horizontal control covering four or five 
cells  

4. Next click on the [Properties] button on the Control Toolbox  
5. Set LargeChange to 10, Max to 100 and TickFrequency to 10 - note 

there is no LinkedCell property  
6. [Close] the Properties window then click on the [View Code] button on 

the Control Toolbox  

This takes you into the Visual Basic Editor, with a Subroutine ready for you 
to type in the programming code to set up the Linked Cell. Just follow the 
instructions below. 

7. Type Range("a2") = slider1 then close the Editor by clicking on the 
red [Close] button  

8. Press the <down arrow> key at least once then click on the [Exit 
Design Mode] toolbar button  

9. If you find a second slider has appeared on the Formula Bar click on 
[Undo] - this was the only reason for moving the slider in step 8 (it 
looks like there's a bug in Excel)  

10. End by testing out the slider: 
a) Drag the slider block to the left or right, or 
b) Click to the left/right of the block to jump in steps of 10  

Note how movements of the slider are reflected by the scroll bar control. 

Slider controls aren't nearly as useful as the others - nor are they easy to 
install. However, it has introduced you to another whole area of complexity. 
The subroutine you wrote could be much more complicated and could be 
used to set different starting values in A2 and other cells, depending on 
various conditions. 

 

Other Controls 

There isn't time to discuss all the other controls - just be aware of their 
existence. Ones which might be of particular use include: 



• Toggle Buttons, Check Boxes and Option Buttons - these can be 
used to switch a value in a cell between TRUE and FALSE and could 
be used to reset the starting values for an iteration, for example  

• List Boxes - these display a list of possible values, from which you 
choose to set a value in a cell. If the list is longer than the drawn box, a 
scroll bar appears  

• Combo Boxes - these are the same as List Boxes except that the list 
is hidden by default (as such, they take up less space). You only open 
up the list when you want to to select the required value  

Try setting up a control, if you like, following the same instructions as for the 
other controls. 

 

Adding Controls to Charts 

Although control buttons do not work on chart sheets, they can be added to 
charts on ordinary worksheets. To do this: 

1. Click on the [Design Mode] button then select one of the existing 
controls - eg a spin button  

2. Right click on the control and choose Order then Bring to Front  
3. Using the mouse or arrow keys, move the control onto the chart (eg to 

the bottom right corner)  
4. Click on [Exit Design Mode] to return to normal working  
5. Test out the control to check that it still works  

You can, if you like, group the chart and its control into a single entity. This 
has the disadvantage that the chart then becomes an object such that when 
you select it, the Chart menu no longer appears (so don't try it here). To 
make a group, use shift click to select both objects in Design Mode then 
right click and under Grouping choose Group. 

Note that charts and controls do not have to be on the same worksheet as 
the data. If you move them to a new sheet then all you need to do is set up 
the Linked Cell so that it references the data sheet (eg Sheet1!A2). 

 

 

 

 

 



A Final Example 

In this final example, three curves will be used, each moving in different 
directions. Don't worry about the mathematics: 

1. Click on cell A2 then position the mouse cursor on the border (a four-
headed arrow appears)  

2. Hold down the mouse button and drag the cell to E5 then release the 
mouse button  

Cell A2 is the Linked Cell for the spin button and scroll bar controls. 
Dragging and dropping it like this will have changed the corresponding 
property for these controls 

3. Move to cell B1 and type y1, press <right arrow> and in cell C1 type 
y2  

4. Press <right arrow> again and in cell D1 type y1+y2 - press <Enter>  
5. In cell D2 type =b2+c2 then double click on the cell handle to copy the 

new formula down the column  
6. Press <left arrow> and in cell C2 type =sin(($E$5-a2)/10) - you 

need to fix cell E5 here, hence you must use an absolute reference 
(Tip: press <F4> after you type E5 to add the $ signs automatically)  

7. Press <left arrow> and change the formula in B2 to 
=sin(($E$5+a2)/10)  

8. Press <left arrow> and type the number 0 into cell A2 - press 
<Enter>  

9. Select cells B2 to C2 then double click on the range handle to copy the 
new formulae down the columns  

10. Finally, move to cell A4 and [Copy] the formula to A3 (use <up arrow> 
then <Enter>)  

Your data is now complete, but a few changes need to be made to the 
chart: 

11. Click on the chart, to activate it, then open the Chart menu and choose 
Source Data...  

12. Change Data range: to read =Sheet1!$A$1:$D$101 then press <Enter> 
for [OK]  

13. Next open the Chart menu and choose Chart Type...  
14. Select Scatter with data points connected by smooth Lines without 

markers - press <Enter> for [OK]  



15. Finally, double click on the vertical y-axis and, on the Scale tab set 
Minimum: to -2, Maximum: to 2 and Value (X) axis Crosses at: to 
-2  

16. Press <Enter> for [OK] then use either the spin button or scroll bar to 
run the iteration  

You should find that the one graph moves backwards, the other forwards, 
while the sum of the two moves up and down. This set of results does have 
considerable scientific significance, but these notes are not the place to 
discuss this. 

In step 16, above, either the spin button or scroll bar could be used; the 
slider, however, cannot. This is because the Visual Basic code still refers to 
A2 as the linked cell. To rectify this: 

17. Try using the slider to run the animation - part of the curve appears but 
it's static  

18. Open the Tools menu and choose Macro... then Visual Basic Editor  
19. Change Range("A2") = Slider1 to read Range("E5") = Slider1  
20. Close the Editor the then reset cell A2 to 0  
21. Try out the slider - it should now be working, though isn't nearly as 

exciting as using the other controls  
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